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You may not reproduce, transmit, transcribe, store in a retrieval system or translate 
into any human or computer language this manual and software. These actions, in 
any form or by any means, are illegal without the express written permission of Pu-
ritas Springs Software. 
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During the period of time before a major upgrade, if the compact disk that makes up 
the then-current version of this software is defective, you may return the compact 
disk to Puritas Springs Software, 645 McKee Trail, Hinckley, Ohio 44233-9209 
and a replacement disk will be mailed to you. Puritas Springs Software reserves 
the right to define and decide what constitutes a major upgrade. 
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Puritas Springs Software provides Ohio Fiduciary Tax, consisting of both the 
software and this manual, "AS IS." The software and manual carry no warranty as 
to performance, merchantability or fitness for any particular use. Puritas Springs 
Software specifically disclaims all warranties, express or implied, regarding the 
software or our services, and Puritas Springs Software does not warrant that the 
software or services are free from defects, interruptions, errors or other program 
limitations. For states containing limitations on implied warranties, any such implied 
warranties are limited to 60 days from the date of purchase. The rights provided by 
this Limited Warranty shall be limited to the original, registered and recorded pur-
chaser of the software. Said rights are limited to the cost of the software and are 
non-transferable.  You assume all liability and responsibility for the accuracy of any 
form produced by this software. Recognizing this, Puritas Springs Software has 
exercised due care in the preparation of the software and manual. In no event, how-
ever, shall the authors or publisher be liable for direct, incidental or consequential 
damages, or damages of any type, arising from the use of Ohio Fiduciary Tax. 
 
This Agreement sets forth Puritas Springs Software’s entire liability and your ex-
clusive rights and remedy with respect to the software. Headings are included for 
convenience and shall not be considered in interpreting this Agreement. This 
Agreement does not limit any rights that Puritas Springs Software may have un-
der trade secret, copyright, patent or other laws, federal or state. 
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Ohio Fiduciary Tax (WIT1041_06) is a 
true 32-bit Windows application and runs on 
any computer running Windows XP, Win-
dows 2000, Windows NT, Windows ME, 
Windows 98 or Windows 95. Because 
WIT1041_06 is a 32-bit application, it will 
NOT run on Windows 3.1 or Windows for Workgroups Version 3.11. 
 
United States copyright laws protect WIT1041_06 as the property of Pur itas 
Spr ings Software. Your WIT1041_06 distribution disk contains a registered serial 
number that is hidden in various places inside the software. Possessors of unauthor-
ized copies violate Federal law. 

 
As noted in the following installation instructions, the files on the WIT1041_06 disk 
are compressed for distribution purposes. You cannot make use of these files with-
out first decompressing them. You cannot simply copy them to your hard drive 
manually. You must “ install”  them using the SETUP application that you’ ll find on 
the distribution disk. 
 
Free Upgrades 
 
The programming and production constraints imposed by the time-sensitive nature 
of the subject matter are obvious. As is true of all tax software, upgrades are very 
important. Described below are several ways in which you can upgrade your soft-
ware. 
 
1. Use WIT1041_06’s Download Upgrade function on the Help menu. 

2. Email your inquiry (include the program name and your present version number) 
to: version_inquiry@puritas-springs.com 

3. You can also phone in your inquiry to the telephone number provided in the as-
sociated materials. 

 
See pages 5 and 6 of this manual for  more specific instructions about reinstall-
ing and upgrading Version 6. 
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In General 
 

Install Ohio Fiduciary Tax (WIT1041_06) to your 
hard drive by following the steps outlined below. 
Before starting the installation, we should mention 
that the files on the distribution compact disk (CD) 
are compressed, and therefore, you must “ install”  
WIT1041_06 to your computer rather than simply copying the files from the CD to 
your hard drive. For that same reason, you cannot run WIT1041_06 from the CD. 
You must install WIT1041_06 to your hard drive. 
 
Network Computers. WIT1041_06 is an ordinary 32-bit Windows program. It is not 
a “network”  program in the sense that it permits simultaneous access to a file by mul-
tiple users. However, WIT1041_06 runs on network installations so long as you have 
purchased a network license. In the case of network computers, the types and imple-
mentations are diverse and we cannot give network-specific technical support al-
though we answer questions about WIT1041_06 to assist network administrators on 
issues involving installation and setup if you have purchased a network license. 
 
Installation 

 
A.  Place the disk in your drive. 
 
B.  On most systems, depending on your license, installation will begin automatically, 
however, if the installation wizard does not star t automatically, take the following 
three steps: 
 

1. Press the Start button; 
 
2. Click on the Run item; and 
 
3.  Type the command shown below. Note that if you’ re installing from a dif-

ferent drive, you must use the correct drive letter. 
 

D:\SETUP.EXE 
 

C. The Setup progress meter will appear briefly until the Welcome dialog appears. 
Click the Next button to proceed with installation. Follow standard Windows in-
stallation protocol by making sure all other applications are turned off—not just 
minimized, but terminated. Click Cancel if you want to abort installation. 

 
D.  The Pur itas Spr ings Software L icensing Agreement appears in the next dialog. 
Click the “ I accept the terms in the license agreement”  and click Next to continue 
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with the installation. If you do not agree to the terms of the Licensing Agreement, you 
will not be able to continue installing the program. 
 
E.   Verify your user identification information and click the Next button. 
 
F.   The installation begins when you click the Install button in the dialog that permits 
you to verify your installation parameters. When copying begins, a progress meter 
will keep you informed as the program files are transferred from the CD to your hard 
drive. 
 
G. When the entire installation process is complete, the InstallShield Wizard Com-
pleted dialog advises you that the installation process was successfully completed.  
Decide whether or not you want to launch WIT1041_06 by verifying the appropriate 
status of the “Launch the program” checkbox and then click Finish to end the instal-
lation. 
 

Running WIT1041_06 
 
After installation there should be a WIT1041_06 icon on your desktop. You can dou-
ble-click on the icon to start the program. You can also start WIT1041_06 by clicking 
on the Start button, selecting the Programs submenu, then the Puritas Springs 
Software submenu and finally selecting the WIT1041_06 item. Depending on the 
type of license you purchased (i.e., single-user, multi-user or network), you may need 
to keep the WIT1041_06 CD in the drive when you start and use WIT1041_06. If 
your license has this condition, you will receive an error message number (38xx) 
alerting you to this fact and the application will terminate. 
 

Updating and Reinstallation 
 
If you ever request and receive an updated WIT1041_06 CD, or if you download an 
upgrade over the Internet, please read this section for additional useful information. 
Note at the outset that installing the new version will require that you uninstall the 
“current version.”  When we refer to the “current version”  we mean the presently in-
stalled Version 6 NOT Version 5+. When installing or reinstalling Version 6, you will 
not need to remove Version 5+. Version 5+ is used for calendar/fiscal year 2005 and 
should remain on your computer as long as you deem necessary. 
 

Summary Table 

 

I f you’ re installing /
reinstalling Version 6 

What to do with 
Version 5 

What to do with 
Version 6 

Installing Leave it alone Not Applicable 

Reinstalling Leave it alone Remove currently installed 
version before reinstalling 
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If you want to download an upgrade from our web site, please read this section. 
 

1. Download the Upgrade. 

A. Click on WIT1041_06’s Help menu and select Download Upgrade. 

B. In the Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software 
and/or hardware in place that prohibit downloading executable files. If this is 
true in your office or you are having problems with the download, check with 
your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-
sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 
Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 
you’ re done. 

3) A message indicates an error, i.e., “HTTP Get Failed.”  Talk with your 
network administrator or send in your disk according to our instructions 
on the Current Versions page of our web site: www.puritas-springs.
com. 
 

2. Remove WIT1041_06. First, it is impor tant to know that removing the 
WIT1041_06 program using Windows’  Add/Remove function will not delete 
or  harm your  client files. That being said, you should always back up the Files 
subfolder that is contained within the WIT1041_06 program folder. It is there 
that your client files are stored. The default path is C:\Program Files\Puritas
\WIT1041_06\Files\. Here are the steps for removing the prior version of 
WIT1041_06. 

A. Exit the WIT1041_06 program. 

B. Click on the Start button. From the Start menu select Settings, and then 
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in a different way. However, once in Control Panel, 
double-click the Add/Remove Programs icon. If you don’ t see the Add/
Remove Programs icon, you may need to click on the Classic View link or 
option. 

C. Select WIT1041_06 from the program list within the Install/Uninstall tab. 
With the WIT1041_06 item highlighted, click the Add/Remove button. 

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process. 

E. The next dialog box to appear is titled Program Maintenance. Click the ra-
dio button next the Remove item, and then click the Next button. 
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F. Remove the Program is the next dialog box to appear. The InstallShield 
Wizard will begin to remove the old WIT1041_06 program when you click 
the Remove button. 

G. You are notified when the removal function is complete. In the dialog box that 
appears, click the Finish button to close the InstallShield Wizard 

3. Install the New Version. The final step in the upgrade process is to install the 
new version by executing the file you downloaded. The name of the downloaded 
file is setupwit1041_06.exe (note that sometimes the exe extension is hidden) 
and it is located by default at C:\Program Files\Puritas\WIT1041_06\. When 
you find the file, double-click on it and follow the installation instructions con-
tained on page 4 of this manual. If you don’ t know how to find the file, try fol-
lowing these steps: 

A Go to My Computer 

B Double-click the C:/ or Local Hard Drive icon. 

C Double-click the Program Files folder. 

D Double-click the Puritas folder. Note that you may be required to click the 
option Show Hidden Files in order to find the Puritas folder. 

E Double-click the WIT1041_06 folder 
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When you start Ohio Fiduciary Tax—2006
(WIT1041_06), it displays a blank Form IT-
1041 (blank except for any default information 
that may be present in the DEFAULT.IT6). The 
cursor is blinking near the top of the form in the 
section for fiscal year filers. The text box will 
move around on the form as you enter information. Use the  �  (TAB) key to move 
from field to field. You can also point to different areas of the form with your mouse 
to jump to remote spots of the form without needing to hit �  repeatedly. By the way, 
if you don’ t have the inclination to type the information contained in the following 
tutorial, you can follow along by opening the SAMPLE.IT6 file contained on your 
hard drive. Simply click on the File menu, select the Open command, then select the 
SAMPLE.IT6 file and click on the Open button. 
 
Step 1. Complete Form 1041, page 1, up to line 1 
 
When you first start WIT1041_06 or when you select New from the File menu, you 
get a fresh blank Form IT-1041. The top of Form IT-1041 is the place where all the 
basic taxpayer information is entered. This information, in particular, is used as a da-
tabase for the rest of the return. In other words, when you complete the taxpayer’s 
name and tax identification number, etc., this information automatically transfers to 
all the other related forms as required. To begin this tutorial, start at the top and work 
your way down to line 1. 

Figure 1 – Completed top portion of Form IT-1041. 
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Here We Go 
 
IMPORTANT: Press � after every entry.  In order to give you a more complete 
understanding of the data entry process, we created the screen on the prior page us-
ing the entries below: 

1 The first area of focus is the Federal Employer ID Number. This entry field 
will be highlighted. Enter 34-1001456. 

2 Press ���� once to advance the text input box to the Social Security entry field. 
This field is used for decedent’s estates only. In this example enter: 123-45-
6789. 

3 Press ���� once to advance the text input box to the Month entry field. Enter the 
beginning month of the tax year. In this example enter: April. 

4 Press ���� once more to advance the input box to the Name of Estate or Trust 
field. You might have to use the second line for the name if it’s a long one. You 
can enter: Joseph E. Sample Estate, Deceased. 

5 Press ���� enough times to advance the text input box to Fiduciary Name. Enter 
the name of the fiduciary: Charles R. Smith, Executor. 

6 Using the ���� key to move from field to field, complete the remaining entries as 
shown below. Remember to press ���� after each entry. 
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 �
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At this point, your cursor should be positioned at Line 1 - Federal Taxable In-
come. With respect to the $351,520 income amount mentioned in the next para-
graph, note that WIT1041_06 does not accept dollar signs ($) or commas (,) in dol-
lar or other numeric entries. Therefore, simply enter the proper numbers and 
WIT1041_06 will add the necessary punctuation. 

 
Enter 351520 as the income amount on line 1 (federal taxable income) and press the 
���� Key.  
 
The next field of focus is line 10, credits from Schedules C, D & E. No doubt you’ ll 
have noticed that WIT1041_06 skipped lines 2 through 9. That’s because 
WIT1041_06 performs all the necessary calculations for those lines automatically. 
You simply keep on tabbing from field to field on a form and progress through the 
various forms on the Display menu and WIT1041_06 takes care of the rest. 
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Note also that the line 10 text input box has a light-blue background. Line 10 is an 
example of a certain type of text input box that has special characteristics. It is like 
lines 2 through 9 in that WIT1041_06 calculates the answer automatically. Yet it is 
also like the text input box on line 1 in that you can also type information to super-
cede what WIT1041_06 has put there. You do this by using the Override command 
on the Options menu. 
 
Believe it or not, you are essentially done with data entry.  There’s just one or two 
more points regarding credits. Before we get to the credits, ...   
 
TAB &  SHIFT TAB. If you’ re following through this example, you’ ll note we told 
you to use ���� after each entry. This works best and is the recommended Windows 
method of moving focus. In addition, you can use the �  key when you’ re on a 
form in the same way as you use ���� . For some, the �  key is the natural, type-
writer way of doing things, however, the Windows way is to use ����  to move the text 
box (or focus as it is sometimes called) and we encourage you to get in the habit of 
using ����  instead of � . You’ ll understand why as you use Windows programs 
more and more. I f you hold the ���� key down when you press ���� or � , you 
can move the focus backwards to return to a previous entry. 
 
 
Step 2. Give the File a Name 
 
When you first start a file, it has no name. You are reminded of that if you look at 
the title bar where it says NONAME. 
 
Don’ t work for too long without a file name. After you put in a few crumbs of infor-
mation like we just did in this example, you’ ll want to use the File|Save As com-
mand to give the file a name. Use any legitimate 32-bit Windows file name. Better 
yet, omit the period and extension entirely and let WIT1041_06 add it automatically. 
Once the file has a name, you’ ll see it on the window’s title bar . To avoid losing 
your  file or  similar  confusion, make sure you save your  files in the C:\Program 
Files\Puritas\WIT1041_06\Files directory. 
 
Here’s a few rules about choosing file names: 
 
1. Don’ t use periods in file names except to delimit the extension. WIT1041_06 al-
ways appends the period and extension automatically: .IT6 
 
2. Don’ t alter the program-associated extension. The extension should always be 
IT6.  
 
3. Always save your files in the designated directory. By default the location is: 
C:\Program Files\Puritas\WIT1041_06\Files\. The location can be set perma-
nently using the appropriate command on the Options menu. 
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Step 3. The Credit Worksheets 
 
As alluded to in Step 1, you still need to complete two of the credit worksheets. 
 
You can find the Credit Worksheets item in the Display menu. The first work-
sheet displayed is the Retirement Income Worksheet. In our example enter 
56000 and press the ����  key.  
 
The focus now moves to the Senior Citizen Worksheet. Click on the checkbox to 
affirm that the decedent’s age at time of death was 65 or older. Press ����  and you’ re 
done. WIT1041 calculates the actual senior credit, just as it calculated the retirement 
income credit from your prior entry. 
 
 
Step 4. Finishing Up 
 
Other  Forms and Calculation Order  
 
This sample decedent’s estate gave you a step-by-step introduction to 
WIT1041_06’s entry system. The sample was included to give you practice with the 
basic system of entering information, not to take you through every field of every 
form and schedule of a more complex return. 
 
Undoubtedly, you will be dealing with more difficult returns than the sample. When 
you do, you may find the list below handy. Although you can complete forms and 
schedules in any order, you will find the list below parallels the logical progression 
of the 1041 computation. If you follow this order, you’ ll be sure to cover everything.  
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Step 5. Previewing &  Pr inting 
 
When you click on the File|Print|Selected Forms command, a dialog box appears 
in which you can select the forms you wish to print. You can print any form or com-
bination of forms from the Selected Forms dialog. Of course you can print forms 
and schedules individually from the Print menu, but we find the Selected Forms 
dialog most convenient. 
 
If you wish to modify the forms or add notes or comments, you may want to use the 
Sent To Word Processor feature that is explained in detail below. With older 
printers or printers lacking sufficient memory, it is often possible to print forms from 
your word processor when WIT1041’s print function doesn’ t work as expected. 
 
Sending Forms to Word Processor  
 
WIT1041_06 has the ability to create an RTF file that your word processor can read 
so that when you “send”  your forms, your word processor is started and the gener-
ated RTF file is opened automatically. The purpose of this feature is to let the user 
make form and substance modifications to forms and data that would otherwise be 
impossible within the confines of the WIT1041_06 program itself. Microsoft devel-
oped the RTF standard so it comes as no surprise that Microsoft’s Word for Win-
dows is best at reading RTF files. Therefore, if you have MS Word, you should go to 
the WIT1041_06 Options menu and select Word for Windows as your word proc-
essor using the Set Word Processor item.  
 
WordPad. If you have Windows 98 or a later version of Windows, your best choice 
of word processor may be WordPad. If you use WordPad, you should be able to 
print your forms with little or no adjustments except that you must set the margins as 
follows: top=0.50” ; left=0.50” ; right=0.50” ; and bottom=0.25” . The good thing 
about WordPad is that it remembers your margin settings. Once you set the margins 
you’ re good forever. The bad thing about WordPad is that its ability to read format-
ting information is somewhat lacking. Again, setting the margins is very impor-
tant because it governs both line breaks and page breaks. So, if you’ re using 
WordPad you’ ll want to set the Page Setup parameters that are available on Word-
Pad’s File menu.  
 
WordPerfect. WordPerfect also reads and writes RTF files but its ability to do so is 
severely hampered by the fact that it miscalculates exact line spacing.  
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This paper manual is merely an outline of the basics of installation, getting started 
and simple information entry. From there, you can get help via the program’s 
Help|Table of Contents menu. 
 
If you’ re like us, you might be doubtful as to whether help files can be truly helpful. 
Regardless of  any drawbacks, we found them to have significant benefits over their 
paper counterpart. 
 
Help Is Always There 
When we were at the office, the manual was at home. When were on the computer at 
home, the manual was at the office. On unfortunate occasions, that alone can make 
you lose a day. It never happens with help files. They’ re always there. A copy for 
your home computer, and a separate one for the office. Ditto for your laptop! When 
you’ re desperate for information, you can always count on its accessibility. 
 
Help Is Hyper linked, Searchable &  Better  Indexed. 
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’ re looking for a snatch of text. 
The point and click links between key words provide instant information without 
fumbling though page after page looking for something. This non-linear  characteris-
tic is part of what makes help files so uniquely useful. 
 
Help Is Up To Date 
Because they are printed in larger quantities, paper manuals fall out of synch with 
last-minute or late-minor programming changes during the duration of the “printing.”  
Help files, on the other hand, are easier to keep current with programming changes 
because their modification involves no additional processing steps to implement (i.e., 
physical transportation, printing, binding, etc.). 
 
Paper  Fix 
You can print any help topic by simply pressing the help window’s Print button, or 
using the menu’s Print Topic command. 
 
Form WIT1041 Instructions The entire printed instructions for Form 1041 and as-
sorted schedules can be found on the Instructions item of WIT1041’s help menu.  
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Checking out the following help topics before 
digging in to WIT1041_06 will reduce the 
learning curve, although you should find 
WIT1041_06 relatively straightforward to use. 
 
1. Download Upgrades 
Just like tax-time is crunch-time for preparers, 
it’s also crunch time for programmers. We try 
to create a perfect program within days of the 
Form 1041’s release by the Ohio Department of Taxation. This means that revisions 
are more the rule than the exception. Note that WIT1041_06 has a Download Up-
grade item on the Help menu that lets you obtain late-breaking programming 
changes 24 hours a day, 7 days a week. 
 
2. Overr iding Answers 
You’ ll use this command when you need to manipulate entries in text input dialogs 
that have light blue colored backgrounds. 
 
3. Using The Keyboard 
This is a good topic to print because it summarizes all the key commands that are 
available in the program. 
 
4. Ohio Fiduciary Tax Instructions You can access these topics from the 
WIT1041_06 Help menu. The entire printed instructions for Form 1041 and assorted 
schedules can be found on the Instructions item of WIT1041_06’s help menu.  
 
5. What is the DEFAULT.IT6 file? 
This topic is a subtopic of the Essential or Common Questions topic. It explains how 
to customize the blank, start-up tax file so that common, usually unchanging informa-
tion is set up to appear automatically when you select New from the File menu. 
 
  
 
 
 


